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The Elm Tree

S

o, we have reached December! Is it my imagination or does it seem
that there are two Decembers in each year? I can remember as a
child (I was once) being told by my parents that “you will need to wait
until next Christmas”. That was to wait for an eternity. Now however,
December seems to pop up very regularly.

I mentioned last month that we are seeking new premises and I explained the reason. Our
search is continuing. Again, as mentioned last month there is good reason for being located
in a suburban area. The main criteria for such a change will be access to public transport
and close public parking. This will then allow people to drive to our location and avoid city
access. Our search is continuing and we have currently short-listed several properties. I
expect to advise our new address in the next newsletter.
The premises that we have been seeking will include space for a small meeting room in
which we can run mini-workshops on various technical aspects of computing. The scanner
will also remain available for the use of members.
In closing, I wish all members and their families a happy and joyous Christmas and trust
that 2020 will be a good year for all of us and hopefully, we will breakdown our “brick
walls”.
As usual to finish on a lighter note:
Lowery’s Laws:


If you fiddle with a thing long enough it will break.



If it jams – force it. If it breaks, it needed replacing anyway.



Anything can be made to work if you fiddle with it long enough.



When any mechanical contrivance fails, it will do so at the most inconvenient time.



It is a mistake to allow any mechanical object to realise that you are in a hurry.



Logic is a systematic method of coming to the wrong conclusion with confidence.

(Particularly applies to photocopiers Ed)

And finally, Ray’s rule for precision:


Measure with a micrometre, mark with chalk and cut with an axe!

Happy Christmas to all
Doug Elms, President

president@vicgum.asn.au			
					
					GUM
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Family Tree Maker 2019
Using the new Tree Browser, or,
Help!!!! I have lost my File

Handling a lot of the internet and phone
help messages to GUM over many years
provides an interesting insight as to our
members’ confidence in using Family Tree
Maker and their comfort, or otherwise,
using their computers.

Sometimes it goes like this.
Agitated Caller: “Help I have lost my family file”.
GUM: “I don’t think you have lost your file, please explain your problem?”
Caller: “I opened Family Tree Maker and my file has gone”.
GUM (resisting the comment to ask if it has fallen out of the computer and maybe is on the f loor.
humour is not appreciated in this situation.)
GUM: “Do you have a good manual backup?”
Caller, after a long pause: “I think I made one 6 months ago”. (Hmmm not very helpful)
GUM: “What is the name of your missing file?”
Caller: “I don’t know, it has just gone”.
GUM: “What OS (Operating System) do you use?” “Win7, Win10 or Mac?”
Caller: Answers vary but we normally get to it finally.
GUM: “OK, Family Tree Maker files all end in .FTM. That is dot FTM. Please open your Windows
Explorer (Win7) File Explorer (Win10) or Finder (Mac) and we will find it”.
Caller: What is (insert Windows Explorer, File Explorer or Finder)?
Houston, we have a problem!!!
I could go on, but there are a few lessons here and also the opportunity for me to explain one of the
new features of Family Tree Maker 2019, namely the Tree Browser.

Know what your file name is and where it is stored on your
computer
In some ways making it easy to use Family Tree Maker has made it
too easy in that to normally open the application you click on the
desktop icon, the application opens and there is a list of previously
opened files. That is all that a lot of users need. But there is a trap.
If there is a problem and [say] Family Tree Maker has lost the link
to the list of recently opened files, then some users are in trouble,
hence the above phone log.
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So where is your file name?
In just about every application, the
name of the open file is displayed
on the top left hand bar. In my case
(Windows) it shows the FTM 2019 icon then the file name, then my FTM version - “Donaldson
Main File – Family Tree Maker 2019”. So it is telling me the open file name and what application it
is running in. In Family Tree Maker 2019 (Mac) it shows the open filename in the middle of the top
bar. Both are clear and you as a user should, if you need to, make a note of the file name. Believe
me, if you are looking for a file on your computer, it really does help if you know its name. I know
that sounds trite, but you would be surprised how many GUM members do not know the name of
their Family Tree Maker File!!

Where is your File?
Typically Family Tree Maker saves your files in a folder called FTM 2019, or FTM 2017, etc.,
unless you have designated the application to save them elsewhere. As you know there is no Save
button in Family Tree Maker as the application saves after every keystroke, and when you close the
application it saves the entire file in the same folder as it was opened from. And as this is largely
automatic, if something goes wrong the panic as noted above ensues.

File>Open
If this happens then Family Tree Maker is like just about any other
application. If it opens and can’t find the recent file, then from Family Tree
Maker do a File>Open or Ctrl+O (Win) Cmd+O (Mac) [O is letter O] and
navigate to where your file is located. Note: Ctrl is short for the Control key,
and Cmd is short for the Command key. This is where knowing the file name
and its location is very helpful. While users use File>Open to open various
[say] MS Word files from Word with File>Open on a routine basis, their
mind apparently goes blank when in Family Tree Maker. As an exercise when
reading this article, open Family Tree Maker and try a File>Open.

Backing Up
The three most important words in computer family history are, Backup, Backup, BACKUP!!
Yes, I know that Family Tree Maker has a so-called automatic backup and in my view it is very
misleading and a total waste of time as all it does is make a backup of your file without media,
and puts it in the same working folder on your hard drive/solid state drive (SSD). When the main
working drive eventually fails, as they all do, then the auto backup fails too. It is interesting in
Family Tree Maker 2019 (Win) you now get a message about turning the auto-backup off. You
don’t, for some reason, get the message on the Mac version.
Now Family Tree Maker 2019 has a new feature called TreeVault to automate file backing up
(although it does not back up media). It is their top version 2019 feature and even has a $30 per year
per file charge associated with it. It is partially working although the Android app is still in beta
and coping with multiple trees is still not finalised. Apparently there is a forthcoming free 24.1
patch coming for version 2019 to address these issues. I will review TreeVault in a future article
when it has been completed and I can evaluate it.
In the meantime I strongly advise you to do a regular Manual backup (File>Backup) and save
the .FTMB backup file in an external hard drive and/or the cloud. I use an off line hard drive and
Google Drive and include my media and Ancestry link. I write about backing up about every three
years under a Risk Management heading, the last article being July 2018. The question that you
need to honestly answer is, ‘what you do if your computer was stolen, caught fire, was destroyed,
crashed, etc.?’
This of course applies to all your important files, not just family history.
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Two Essential References:
Backing Up
https://support.mackiev.com/159217-Backing-Up-a-Tree-File-in-FTM-2017-and-FTM-2019

Restoring
https://support.mackiev.com/487839-Restoring-from-a-Backup-in-FTM-2017-and-FTM-2019

Tree Browser
Well, now to the new Tree Browser.

What it essentially does, and does it brilliantly well, is to find EVERY tree created by Family Tree
Maker regardless of where these trees are located, i.e. on your computer, on Ancestry, in Tree Vault.
It will find all trees created in Family Tree Maker 2008 or later (these end in .FTM) all GEDCOM
files (these end in .GED) all the autobackup files (.FTMB) and even those created by versions of
Family Tree Maker from version 2 through to version 16, that end in .FTW!!!

Opening Tree Browser
In 2019 Win you can open Tree Browser by either going to the View Menu and select Tree Browser,
or in the list of Recent files you can open it there or you can use the keyboard shortcut Ctrl+0.
(That is a zero). In the Mac it is exactly the same except the keyboard shortcut is, as you would
expect, Cmd+0. (That is a zero).
This opens the Tree Browser dialog. Spend a bit of time reviewing it as it has a lot of capability.
So for all you who don’t feel confident finding files a new ‘get out of jail free’ app. This is how
Software MacKiev (SMK) suggests you use it.
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Using Tree Browser
Tree Browser makes it easy to locate, view, and manage all of your trees, all in one place. Whether
it’s an FTM, Ancestry, or TreeVault tree, a backup file, or a GEDCOM, you can quickly find what
you’re looking for and see everything you need to know about it. Tree Browser also enables you to
track down tree files you have misplaced, even in the most obscure corners of your computer’s hard
disk. (Do hard drives have corners? Ed).
1.	Choose View>Tree Browser, or click the Select Tree drop-down list on the main toolbar
and then click Tree Browser. (or Ctrl+0 (Win) or Cmd+0 (Mac)The Tree Browser window
appears. (0 means zero).
2.

In the left part of the window, select the group of trees you want to work with:

•

Recent: The trees that you have recently had open in Family Tree Maker.

•

A ll Trees: All of the tree files on your computer that you can open in Family Tree Maker.
The tree files are sorted by category: files from the current version of Family Tree Maker,
files from previous versions of the application, backup files, and GEDCOMs.

•	
F TM Folder: The tree files in the folder that Family Tree Maker uses to store your FTM
trees. By default this is the Family Tree Maker folder located in your Documents folder. The
tree files in this group are also sorted by category.
•

Ancestry: Your online Ancestry trees.

•

TreeVault: Displays the status of the tree in your TreeVault account.

A list of the trees in the selected group appears to the right.
3.

Use the Sort by and Show drop-down lists to narrow your search for a particular tree.

4.	Select a tree in the list to view information about it in the right part of the Tree Browser
window.
5.

Do one of the following:

•

Click Open Tree to open the selected tree in Family Tree Maker.

•	Click Open File Location to open the folder where the selected tree file is located in the File
Explorer (Win) Finder (Mac).
•

Click Delete Tree to delete the selected tree file from your computer.

•

Click Browse to try to locate the tree you want manually.

The buttons available may vary depending on the kind of tree you have selected.
To create a new tree from Tree Browser, click the New Tree button in the bottom-left corner of the
window.
To find a tree by name: (see why it is good to know your tree name, Ed).
1. Open Tree Browser.
2. Click in the search field.
3. E
 nter the name or a part of the name of the tree that you want to find, then press Enter. A list of
trees that match what you’ve entered appears in the right part of the window.
4. S elect a tree to view information about it. If this is the tree you were looking for, use the available
buttons to take the actions you want. See step 5 above for information about using the buttons.
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Comments
Pretty slick?
I was surprised how many trees I had on Ancestry, but thinking about it, most were created at
various workshops and user groups so after taking a few screen shots for this article, I used the Tree
Browser to delete them all. In this instance Tree Browser was great in easily locating them all and
allowing me to delete them conveniently in Family Tree Maker without having to go online.
I was also impressed with the ability to search for a tree even if you only know part of the name, but
a full name is better, of course.

Reference
As well as the Companion Guide there is an online support article at:
https://support.mackiev.com/232654-Using-Tree-Browser-to-Manage-Your-Trees-

Summary
This is going to be a helpful tool especially for those who have, “lost their trees and
like Little Bo Peep don’t know where to find them”. Maybe now when we get a phone
call about lost files we will ask if the caller is using Family Tree Maker 2019, and if
so happily direct them to Tree Browser.

John Donaldson										GUM
P. S. I do strongly commend that GUM members have at least a passing knowledge of file/folder
management on their computers. For Win 7 it is called Windows Explorer (not to be confused with
Internet Explorer), in Win 10 it is File Explorer, same thing different name and in Mac it is called
Finder which has an absolutely brilliant Spotlight search capability. These applications allow you
to manage your files and folders, to move, copy, paste, rename, find, and just about anything else
associated with file/folder maintenance.
Operating an application like Family Tree Maker is like learning to drive a car, knowing how to
manage your Windows or Mac computer is a bit like knowing the road rules. You need to know
BOTH to drive well. I often suggest to folk that computers will be much more enjoyable if you do an
adult Windows or Mac course.
Failing that, put something like “YouTube File Explorer” into Google and you will get links like:
https://www.youtube.com/watch?v=L9G9XTl6ZLM
And for the Mac people try this link https://www.youtube.com/watch?v=ei3KblKsWho

And there are many, many more. Maybe look at one per day?
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T

The Dickman’s Build A Dam

he Dickman family were graziers and sawmillers in the Chinchilla area (Western Darling
Downs, Queensland). By the 1930’s there were two generations trading as ‘Dickman & Sons’.
Harry Dickman and his sons Norm and Ron. Between them they had several properties.
One of these properties was ‘Hawksnest’ in the Burncluith district, near Chinchilla. The family
was constantly improving their properties. In the 1930’s a decision was made to build a dam on
‘Hawksnest’.
I am no engineer and cannot describe the entire construction process, however, this marvellous set
of photographs has survived and provides a visual history.

A scoop was attached to a team of horses using spreaders. Logs were used as the spreaders and
these kept the chains from running into each other as the scoop was operated. The scoop depicted
in these photographs could move about a metre of earth. The spreaders could be made to any
size depending on the number of horses used in the team. The chains were attached to the yoke
preventing any major movement.
Alf Lawson & Harry Dickman were in charge of the teams of horses, spreaders and scoops. More
than one team was used in the construction. A dray was used to bring supplies to the work site. A
‘smoko’ area and makeshift tent was also set up.
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It is not known how long it took to complete the dam, however, on the back of one photo is written;
‘Measuring the depth of the tank. It’s 180ft x 160ft top surface and 15ft deep. Norman & Bobby in
front’.
Robert (Bob) Dickman, pictured in his father’s arms, was born on 11 April 1934.

The colour photo is from 1970 and was supplied by Blue (Peter) & Helga Dickman.
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The black & white photographs are part of the collection of Norm and Doris Dickman who passed
them along to their daughter Doreen Margetts. The photo’s have been scanned and then text placed
onto the picture.
The property has long since passed out of the Dickman family and the property name has been
changed, however, testament to a job well done, the dam is still there and holds water.

Suzanna (Sue) Margetts 2019								GUM

GUM User Groups Recommence Dates 2020
First meetings for 2020
Day FTM User Group:

		7 February

Evening FTM User Group:			

17 February

RUG User Group:				7 February

Ballarat FTM User Group:			

16 February

Geelong FTM User Group:			17 February					GUM
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Charting Companion for Apple "Macs";
Family Tree Maker 2019
Progeny Genealogy is hard at work converting Charting Companion 7 to Apple's macOS 10
operating system. When the conversion is completed, Charting Companion will run on MacBooks
and iMacs. They still have a fair bit of work to do and will notify all their customers when the new
version is ready.
Here are "work-in-progress" screen shots of the Family Group View, Ancestor chart and Descendant
chart running on a Mac: (At last! Ed.)

Charting Companion 7.2.10 has been released to provide compatibility with the new Family Tree
Maker 2019.
If you have an earlier version of Charting Companion, the upgrade policy is:
•	If you purchased after June 2018 (version 7), you get a free upgrade. In the Charting
Companion menu, click on "Help>Check for upgrades".
•

If you purchased after October 2017, you get a discount (contact Progeny).

•

Before October 2017: purchase a new Registration Key.

https://progenygenealogy.com/
Progeny Genealogy 									GUM
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Is Family Book Creator Compatible with
Family Tree Maker 2019?
Please find below compatibility information for
Family Book Creator 2017
Family Book Creator 2019

Family Book Creator 2017
The latest update for Family Book Creator 2017 is a free maintenance release and includes multiple
improvements and fixes and makes the product compatible with Family Tree Maker 2019 on
Windows as well. This means after Family Tree Maker 2019 has been installed on your system, you
need to download the fresh update/installer package for Family Book Creator 2017. Then please
uninstall Family Book Creator 2017 and reinstall the product again to integrate Family Book
Creator 2017 into Family Tree Maker 2019 as well. (Some more details about the latest free update
are available in the Change History document at:
https://www.familybookcreator.com/en/menu-support-en/change-history)

How to integrate Family Book Creator 2017 in FTM 2019
In case you have Family Book Creator 2017 already installed, you need to remove your current
Family Book Creator 2017 version and install again (using the latest Family Book Creator installer
package) to be able to launch Family Book Creator 2017 from Family Tree Maker 2019.

Full Details at:
https://www.familybookcreator.com/en/menu-support-en/menu-faq-en/189-faq-encompatiblewithftm2019Family Book Creator 2019
As mentioned above, the latest version of Family Book Creator 2017 is already compatible with
Family Tree Maker 2019, but there is also going to be a new major release of Family Book Creator
on Windows soon. This new major release is going to be called "Family Book Creator 2019", is
going to have some great new features and the look and feel of the product is going to be enhanced
as well.

What’s new in Family Book Creator 2019?
https://www.familybookcreator.com/en/menu-support-en/menu-faq-en/188-faq-enwhatsnewf bc2019
Family Book Creator 2019 is going to be available for Family Tree Maker 2017 and Family Tree
Maker 2019 on Windows and is going to be free for all Family Book Creator users who bought
their license in 2019. All other Family Book Creator users are entitled to get the upgrade for a small
upgrade fee. I’m going to provide additional information in the FAQs at:
https://www.familybookcreator.com/en/menu-support-en/menu-faq-en
soon after the product is going to be available.

Stefan Harms										GUM
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Stefan Harms at RootsTech, London (26-28 October) on the Software MacKiev Site
Photos: Stefan Harms
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Options: Data Format (Beginner)
Option 3.1 Letter Case of Prefix and Suffix (gbl)

If you choose Initial caps, Legacy will automatically capitalize your prefixes and suffixes if you
enter them in lowercase. Some like this feature because you can type faster and it also keeps you
from making a capitalization mistake. I have mine set to Don't change what I enter because I have
a habit of using the suffix field for things other than a true suffix (many times in privacy brackets).
If you have been using “Don't change what I enter” and you change your mind and select Initial
Caps you will notice the Apply button become active. If you click Apply it will go through your file
and capitalize all of your prefixes and suffixes at one time.

Option 3.2 Letter Case of Given Names (gbl)

This option is pretty much the same as the previous one but in this case I do want Legacy to
capitalize the given names because I am very capable of making a mistake when typing and I have
no given names that would be in lowercase.

Option 3.3 Letter Case of Surnames (gbl)

I have this set to Initial Caps but there are going to be a lot of people that won't want to do this. If
you have a lot of surnames like van der Molen then you don't want to have Initial Caps.
It used to be that UPPERCASE surnames were the norm in genealogy. I think this came about when
we dealt a lot with unindexed books.
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If the surnames were in uppercase you could scan pages pretty fast looking for the surnames. Today
this is not the standard; however, there are many people who still prefer it and so the option is here.
This will trigger a Potential Problem as it isn't the standard. If you want to use uppercase surnames
you need to do two things.
1) Make sure you have this option set to UPPERCASE and then click the APPLY button over on the
right to make sure that all of your surnames are in uppercase.
2) Now go to Tools > Potential Problems. Click the Standardization tab. The very last entry is
Surname entered as all uppercase. Uncheck that box.
Now you are good to go.

Option 3.4 Displaying Surnames (gbl)

These options are for display only. In other words, it doesn't matter how you actually enter them,
this is how they will be displayed on your screen. Most people who want their surnames in
uppercase, want them that way all the time so this option might be a bit redundant; however, /
Surnames/ within slashes is a bit different. Sometimes it isn't obvious which is the given name
and which is the surname. Slashes around the surname will tell you which is which. A lot of older
programs did this and some people like it so we have it as an option. If you had the name Ann /
Kelly/ you wouldn't mistakenly think that her middle name is Kelly and that the surname is
missing.

Option 3.5 Format of Names with Titles (gbl)

This is how names with prefixes and suffixes will appear in the various reports. I do want Legacy to
put a comma before title suffix so that it reads out John Doe, Jr. I am not sure why you would ‘Put a
comma after a title prefix’ but there must be a reason so if anyone does this please post a comment
explaining why.

Option 3.6 Letter Case of Locations (gbl)

This one works the same way as Options 3.1, 3.2, and 3.3. I have no locations that start with a
small letter so I want Legacy to make sure I haven't made a mistake and it to capitalize locations
automatically for me. Again, you have an Apply button so that you can convert all your locations
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with a click of a button. This is very convenient when you have done an import.

Option 3.7 Location Format (gbl)

You can see how I prefer to format my locations in reports. I am not sure why you would want to
remove the spaces because that wouldn't be good English nor would the option to have inconsistent
spacing but apparently some people prefer this and that is why the programmers have included
these options. You can use the Apply button to make sure your file is uniform, especially after an
import.

Option 3.8 Child List Indicators (gbl)

These options give very different displays so it is easier to do this with screenshots. Anything that
has to do with a Direct Line means you have to have already set your Direct Line by going to Tools
> Set Direct Line or the option won't work.
Use Bold and Underline on the numbers to indicate spouses and continued lines
Bold means the person is married. Underline means the person has children. If the person is both
bold and underlined then they are married and have children which is the case in this screenshot.

Use § and + at the end of names to indicate spouses and continued line
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§ means the person is married but has no children. + means that the person is married and does
have children.

Indicate Preferred children in Child List (*)

Indicate direct-line children in lists (bold)

I showed you screenshots of the Children's List but some or all of these will also show up on the
Name/Search List, Pedigree View, Descendant View, Index View, Edit Children and the Siblings
List. On the Name/Search List and Index Views you will only see the Direct Line in bold. The §
symbol there means a married name (a ~ means an alternate name). The Descendant View will only
have the Direct Line in bold.

Option 3.9 Living Indicator (gbl)

I like to keep this turned on because it might alert me to someone that is marked living that should
be deceased or someone that is marked deceased that should be living. When I am working with
DNA I will kill myself off (or whoever is the anchor person for the DNA gedcom I am uploading).
I want the DNA matches to see my name while still protecting those people that truly are alive.
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Sometimes I forget to resurrect myself from the dead.

Alive

Dead

Notice that there is a button to Select Color if you want to change it.

Option 3.10 Term for Christening (ff)

This is the only option in this section that is (ff). Why? If you have more than one file and these
files have different demographics (time, place) you might prefer one term over the other. This
changes the display on the screens but it also changes reports and exports.

Option 3.11 Word for Blank Records (gbl)

If you choose “Unknown” Legacy will automatically insert “Unknown” on your screens and in
reports. I just prefer to leave it blank.

Option 3.12 Potential Problems Indicator (gbl)
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If you have this turned on you will see a >> next to their title on the Family View, if you have
excluded something from the Potential Problems.

And you will see an asterisk (*) on the Individual's Information screen.
That's it for this section. Next up, Options: Data Defaults.

Michele Simmons Lewis, CG®								GUM
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It is Now Official: Say Goodbye to your
Windows PC As You Know It
NOTE: This article is not about genealogy, but I suspect many Windows users will be interested in
it. If you are looking for true genealogy-related articles, I suggest you skip this one.
In the July 30, 2018, edition of this newsletter, I predicted:
“Huge changes are coming from Microsoft. A new rumour is going around that claims Microsoft
is switching from SELLING Windows to RENTING it instead. Some users think it will be an
improvement while others believe it will be a major step backwards to computing in the way it was
done in the 1970s when very expensive mainframes did all the computing and all data input and
output by humans was done by using remote ‘dumb terminals.’
“Microsoft is getting ready to replace Windows 10 with the Microsoft Managed Desktop. This will
be a “desktop-as-a-service” (DaaS) offering. Instead of owning your own copy of Windows, you’ll
“rent” Windows by the month.”
Microsoft made my prediction come true this week. Microsoft has now rolled out Windows Virtual
Desktop (WVD). If you have a fast internet connection, you can run your desktop off WVD today.

Starting now, you no longer need to own a PC with Microsoft Windows installed. Instead, you can
“run” Windows 10 on a Macintosh, Chromebook, Linux, iPad, or Android tablet.
OK, you don’t really “run” windows on the other systems as much as you ACCESS Windows from
almost any computer. That is a critical difference. All you need on these other systems is a web
browser, such as Chrome, Firefox, Safari, Edge, or probably any of the other web browsers.
Microsoft has been testing Windows Virtual Desktop (or WVD) for some time and now has
released the application to everyone. Windows Virtual Desktop is a perfect example of a cloudbased application: the primary program (Windows 10) actually runs in multiple data centres
located anywhere in the world. Not only is the operating system running in remote servers but the
default operation runs all your programs (Word, Excel, email, games, and much more) in the same
servers. Optionally, your files also can be stored either in the cloud or in your own local computing
device, whether that local computer is a Macintosh, Chromebook, Linux, iPad, Android, or some
other computer.
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With WVD (Windows Virtual Desktop), you type on your local computer’s keyboard, use the local
mouse, and view all the activity on your local computer’s screen. However, the local screen simply
serves as a “window” into the software running on remote servers in the cloud.
As Brad Anderson, corporate vice president of Microsoft 365, said, “Companies want to move this
to the cloud. And WVD is really the only way to run real Windows 10 clients, multiuser, in the
public cloud.”
I have heard many Windows users claim, “Oh, I could never use a [Mac, Linux desktop,
Chromebook or whatever] because it doesn’t run my favourite Windows-only program.” That
argument has disappeared. Now almost any computer can access Windows programs. Using WVD,
you can run your Windows apps on ChromeOS, Linux, macOS, Android, or an iPad.
As you might expect, there are advantages and disadvantages to this cloud-based operation. Here
are a few things I can think of:

Advantages:
Lower costs – Instead of purchasing a high-powered and expensive PC to perform heavy-duty
computing, you simply rent time on some very powerful servers located elsewhere and access them
ny using Microsoft’s WVD in your local computer, even if it is a non-Microsoft computer.
The amount of savings will vary widely, depending upon your needs. For instance, if you
need to use an engineering CAD/CAM program (computer-aided design & computer-aided
manufacturing) only occasionally, it seems senseless to spend $2,000 or more for a high-powered
Windows workstation that is only used occasionally. Instead, use a low-powered and inexpensive
Chromebook or iPad or some similar computing device in your home or office with WVD to access
high-powered servers in the cloud and only pay for the number of hours used. The results will be
the same except for significant money savings.
Use almost any computer to access Windows 10 – The WVD client app is available for Windows as
well as Macintosh, Android, Apple iOS (iPad), Chromebook, and any other web browser capable of
running an HTML 5 web browser. All modern web browsers are HTML 5 capable. This means you
can “run” Windows via most of the popular desktop browsers.
Automatic software updates – There will be no need to install Windows software updates. Support
personnel in the various cloud-based data centress will install all Windows operating system
updates for you as well as updates for Microsoft products (Word, Excel, Powerpoint, Outlook,
OneNote, and many more applications). In most cases, the end user will still be responsible for
updates to applications written by other companies, however.
Reduced risk of viruses – The operating system is maintained by Microsoft’s experts, reducing
your risk of viruses and similar problems. The risk is not entirely eliminated, however, especially
for programs installed by you, the user.
Essentially infinite disk space – Since everything can run in the cloud, you can store as many files
as you wish. Disk space should never be a problem in the cloud. It also will be far more convenient
than installing disk drives into your local computer. You obviously will need to pay for the rental
of that disk space; but, in most cases, that will be cheaper than purchasing your own disk drive(s).
Using WVD probably will also be much more convenient and cheaper than replacing your own
local disk drive(s) after a hardware failure.
Backups are automatic – Files stored in the cloud are also backed up automatically all the time.
Even if the cloud-based service suffers hardware failures, your files can be restored quickly by the
system support experts employed by the cloud service. In most cases, the end user will never know
there was a hardware failure; he or she simply accesses everything in the same manner as always.
NOTE: Storage of files in the cloud will be optional: you also can store files in your local computer,
should you wish to do so. Should you elect to store files locally, you will be responsible for making
your own backups of those files.
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Disadvantages:
An “always on” internet connection will be required – This won’t be much of a problem in most
homes and offices, but it may be an impediment when traveling. Not all airplanes, commuter
trains, hotels, coffee shops, parks, or open spaces have wi-fi or cost-effective cellular or satellite
connections available today. That certainly is changing, but wireless connections will not be
available everywhere for a few more years. By the time all Windows users are forced to move to
WVD, wireless access will probably be commonly available in 99% of the homes, offices, and other
locations.
Speed – A fast Internet connection will be necessary in order to enjoy a “smooth operation.” A slow
connection will result in slow performance and “jerkiness” as delays are encountered
Issues with peripherals – While the keyboard, mouse, and screen on your local computing device
should work perfectly, what about scanners or other hardware devices or connections to a tablet
computer, smartwatch, Kindle, f lash drive, or other devices that usually connect via USB? All of
these connections probably will be easy to use someday, but not as simple while WVD is still in its
infancy.
Pricing – Using a cloud-based operating system may be either cheaper or more expensive than
purchasing your own hardware and operating system. Pricing for the new Windows Virtual
Desktop (WVD) may be found at https://azure.microsoft.com/en-us/pricing/details/virtualdesktop/. The pricing schedule is complicated, but it can be as cheap as $0.004/hour US (four-tenths
of one cent per hour for low-powered and low-usage) as listed at https://azure.microsoft.com/en-us/
pricing/details/virtual-machines/windows/. However, many users probably will opt for higherpowered and more expensive services.
Who is in charge? – Using any cloud-based service means that the user is always at the whims and
policies of the cloud service provider. While the odds of Microsoft declaring bankruptcy and going
out of business are slim, other issues can be a problem. First, Microsoft could raise prices at any
time. Next, the U.S. Government can suddenly change its laws and regulations, leaving you out of
business.
NOTE: One example is Adobe. The company is shutting down its application service for Venezuelan
users to comply with a U.S. executive order that prohibits trade with that country. If you live in
Caracas, you soon won’t be able to use Acrobat, InDesign, Illustrator, Photoshop, or Premiere. The
same thing could happen if you relied on Microsoft for your desktop.

Summation:
Microsoft will first encourage corporations to move to Windows Virtual Desktop (WVD).
Individual consumers will not be rushed into making this change; you probably can continue to
use Windows installed in your own computer for several more years. However, there is little doubt
that Microsoft wants everyone to eventually rent their computing capabilities, not purchase the
hardware. Of course, Microsoft will always encourage renting this amount of power from just one
company: MICROSOFT.
As to the Windows PC hardware as a standalone platform, it’s on its way out. The change won’t
happen overnight, but it certainly will happen if Microsoft has its way.
If you don’t want to participate in Microsoft’s visions for the future, now is the time to start
planning on alternatives: Macintosh/Chromebook/Linux/iPad/Android or whatever new hardware
and operating systems appear in the future.

Dick Eastman										GUM
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Apple MacOS Catalina 10.15 Release:
Should You Upgrade Your Mac?

The sixteenth version of Apple’s MacOS, MacOS Catalina 10.15
was released earlier this month on October 7th. Following the
expected path of being announced in the summer at WWDC
before entering a developer beta program.

It has not had an easy launch, with a ‘hot fix’ supplementary
update issued, key third-party applications struggling to
support the new code, and many customers feeling bereft as
support for their favourite apps has been dropped. But it has also brought a number of benefits,
including tighter integration to Apple’s online services, support for running iPad apps, and
debuting Activation Lock on the platform.

Should you be upgrading?
Compatibility
It is expected that Apple will be shipping all new Mac machines with MacOS Catalina 10.15. In
terms of support, Catalina will run on all machines that ran Mojave (the previous named version),
except for Mac Pros released between 2010 and 2012. These could run Mojave using a GPU upgrade,
but will not run Catalina.
Catalina is compatible with the following machines.
•
•
•

Mac Pro: Late 2013 models and onwards.
iMac Pro: All models.
iMac: Late 2012 models and onwards.

Promoted

•
Mac Mini: Late 2012 models and onwards.
•
MacBook Pro: Mid 2012 models and onwards.
•
MacBook Air: Mid 2012 models and onwards.
•
MacBook: Early 2015 models and onwards.
You should be prompted to upgrade your computer to Catalina, but if you are looking to start the
install, you can go to the Apple Menu >Software Update. More details can be found at Apple’s
support page.

Issues
For many, MacOS Catalina 10.15 is a buggy release and has caused a number of issues. There are
sync issues to the cloud (especially in the Reminders app), problems with signing back into iCloud,
BlueTooth issues requiring you to delete and reconnect peripherals, and applications that need to be
tweaked to run in the new environment.
New security procedures mean that you will be asked to ‘re-authorise’ access to files, and
applications distributed outside of the Mac Store will need to be ‘notarised’ by Apple to run out
of the box. While you can still give non-notarised apps access to your system, this is no longer an
option shown on the dialogs - you need to know to dig into the system preferences to give an app
permission. This is part of the new Gatekeeper software and while it does keep the computer more
secure, it also makes users more reliant on Apple.
A number of installation issues have been addressed with two supplemental updates, but as always
it is recommend you do a full backup of your machine before you upgrade the operating system so
you can roll back the changes if needed.
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The biggest issue with MacOS Catalina is the removal of support for 32-bit applications. Previously
both 32-bit and 64-bit applications would run under Mojave. Although Apple has signalled this
change to developers and users, those not as connected to Apple’s new direction have been caught
out when installing Catalina as old apps will no longer run, some are not being ported to 64-bit,
and others are ported to 64-bit but have switched to a subscription model.
Those who are reliant on 32-bit apps or specific apps that are not yet updated should avoid
Catalina until they have a workable solution for Apple’s brave new world. You can check
which of your existing apps are 32-bit by clicking on Apple Menu >About This Mac>System
Report>Software>Application and check if they are 64-bit or 32-bit. (See also page 26 Ed)

Benefits
As a major release of MacOS, Catalina has a huge number of changes, both small and large. The key
points worth noting are as follows.
The aforementioned Gatekeeper (which checks new apps for known security issues) is part of a new
suite of security changes that work with the T2 security chip, that automatically encrypts data and
allows trusted software more access to your data.
The T2 chip also supports Activation Lock in the same way as your iPhone or iPad, which allows
you to remotely lock a misplaced or stolen computer, as well as remotely erasing the data, or
reactivating it as needed.
Catalyst allows developers to easily port iPad applications coded under iPadOS to run on MacOS.
One example of this in use is the return of a Twitter app from Twitter to the Mac desktop - by using
Catalyst the iPadOS Twitter app can be run.
Apple has also tied MacOS closer to iPadOS with Sidecar - this allows your iPad to act as a second
screen to your Mac machine either as an extended or a mirrored display, and that opens up the Mac
platform to the Apple Pencil. Note that your Mac machine must be using an Intel Skylake based
processor at a minimum, which in broad terms means a late 2015 model and onwards.
The other major change is the removal of iTunes and splitting out the media functions to better
represent Apple’s cloud-based services, so get ready to use Music, Video, and Podcasts as standalone
apps.

Wait For The Bugs To Be Found
As a new major release of an operating system, the general rule of not upgrading in the first wave
should really apply. Developers who are in need of the new tools, or those with a second Mac
machine that can be used as a testbed, are going to be adept at dealing with many issues that a
regular consumer is going to troubled with.
Those users comfortable with Mojave and who have a work-critical machine running third-party
software should be especially wary on what they will lose in any upgrade.
Right now, unless you have a business critical reason to upgrade to Catalina, I would
recommend staying on Mojave until the major issues are addressed and tested.
Catalina certainly brings the Mac platform closer to your iPhone and iPad, and the features that
allow the iPad to be used as a ‘second station’ and some iPad apps to run on your desktop are
attractive. Apple has taken this moment to bring the platform closer to the cloud.
With so many small issues cropping up, these all add up to a frustrating experience for those
updating to Catalina. Two supplemental updates have addressed some of the installation issues, but
the vast majority of problems are still awaiting repair.
There’s no reason for most to update to Catalina just now. Mojave 10.14 is mature, works well.

Edward Mendelson 										GUM
(As my number 4 son says to me when I talk about updates, “Dad, if it ain’t broken, don’t fix it”. Ed)
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Apple’s latest version of macOS, Catalina,
officially ditches 32-bit app support, but
you can still run the software you need by
following these steps.
Apple’s latest version of macOS, 10.15 Catalina, looks a lot like earlier versions of the operating
system, but is vastly different under the hood. The biggest change is that Apple ripped out all the
code that, in earlier versions, made it possible to run older 32-bit apps in Apple’s 64-bit operating
system. Apple warned us years ago that this change was coming, and there’s no doubt that an all64-bit OS like Catalina is more efficient than an OS that runs both 32-bit and 64-bit code. Still, for
many users, Catalina blocks apps that they’ve relied on for years. Here, we show you how to run
32-bit apps on an OS that isn’t designed for them.
Before you update to Catalina, find out whether you’re using any 32-bit apps that you can’t do
without. The easiest way to do this is to click the Apple icon in the upper left, then About this
Mac, then System Report, and scroll down to Software/Applications. Your Mac will take a while to
gather information about your apps and then displays a list of all the apps on your machine. Find
the column headed “64-bit (Intel)” and click on the column heading. All your 64-bit apps will show
a Yes in this column. All the 32-bit apps will show a No. You may be surprised by how many 32-bit
apps you have. Study this list, and if you find 32-bit apps that you need, you’ll have to find a 64-bit
update or replacement—or you can implement the workarounds below.
The 32-bit apps you find on your machine are typically of two kinds: older Mac apps that have been
abandoned by their developers (or that developers are slow to update) and apps based on the Wine
software project that lets Macs and Linux computers run Windows software. (Wine stands for
“Wine Is Not an Emulator,” but, effectively, it emulates Windows features so that Macs and Linux
boxes can run some, but not all, Windows applications.)
If you need to run a 32-bit app, Apple unofficially recommends either that you keep an old Mac on
hand that runs a pre-Catalina version of the OS or that you partition your current Mac so that it
can start up with an older macOS version as well as Catalina. Both methods work, but both seem to
me inconvenient and time consuming. There are, however, better alternatives.
The easiest method is this (but keep in mind that it costs money): Buy a copy of Parallels Desktop
or VMware Fusion if you don’t already own one. These programs are designed mostly for running
Windows on a Mac, but you can also use them to create a virtual machine that runs macOS in a
window on your Mac desktop. Parallels is easiest to use, but VMware Fusion isn’t far behind.
The steps are different depending on whether you’re still running macOS Mojave or have already
upgraded to Catalina. Let’s start with the steps to take if you’re still running Mojave. Each step
corresponds to a screen in the slideshow.

1. Launch Parallels Desktop
From the File menu, choose New… to open the Installation Assistant panel. In the Free Systems
section, scroll to the right and click Install macOS 10.14.6 Using the Recovery Partition. (It may
show a different version number on your system.) If you’ve upgraded to Mojave from an earlier OS
version, you may see options to install that earlier version. Choose whichever version you feel most
comfortable with.

2. Create a New Virtual Machine
The next page in the Assistant is headed macOS 10.14.6. Click the Install button. Parallels launches
the macOS installer and creates a new virtual machine. When it’s done, you see a screen asking
you which language to use to interact with your virtual Mac. Choose your preferred language and
continue.
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3. Prep the macOS Mojave Installation
The macOS Recovery Environment now opens in the virtual machine. (This is the screen that every
Mac displays when you hold down Cmd-R at startup.) In the macOS Utilities menu, click Reinstall
macOS. The next screen will offer to install macOS Mojave. Click Continue. On the license
agreement screen, click Accept, and then click the Accept button in the pop-up menu.

4. Install macOS Mojave on the Virtual Disk
Don’t be terrified by the next screen, which offers to install Mojave on a hard disk named
Macintosh HD. This is not your Mac’s hard disk, but a virtual hard disk in the virtual machine that
Parallels created. Click Macintosh HD and then Continue. Now wait while Mojave installs itself on
the virtual disk. This may take more than a half hour.

5. Set Up macOS Mojave
The virtual Mojave will display the same setup screens that the Mac normally displays when you
install an OS.

6. Complete the macOS Mojave Installation
When the installation is complete, you’ll see the default Mojave desktop. From your actual Mac’s
top menu (not the topline menu within the virtual machine) choose Actions, then Install Parallels
Tools.

7. Install Parallels Tools
Follow the prompts to install the Parallels Tools in your virtual Mojave machine, and then restart
the virtual machine.

8. Transfer Your 32-Bit Apps
Drag your 32-bit applications from your real Mac into the virtual Mojave system. Double-click
them to run them. If you’re running Mojave and not an earlier version, you’ll see the familiar popup warning that your 32-bit is not optimized for macOS and will need to be updated. Ignore the
warning.

9. Upgrade the OS
Now you can upgrade to Catalina.

10. Wrap It Up
With a 32-bit app running, go to the Parallels top menu and choose View/Enter Coherence. The 32bit app appears in its own window on your Mac desktop, and a second top-line menu (the menu for
the virtual Mac) appears beneath the top-line menu of your main macOS installation. The virtual
machine’s dock is visible at the foot of the screen, but it’s easy to turn that off from the virtual
machine’s System Preferences.
You can now explore the Parallels options for fine control over your apps and use the System
Preferences app in the virtual Mojave to make one or more 32-bit apps start up automatically when
the virtual machine is launched. (Go the Users & Groups preference pane, then the Login Items
tab.)

Another Catalina Option
But what if you’ve already upgraded to Catalina, or you have a new mac that runs only Catalina,
and you can’t install Mojave into Parallels with your Mac’s recovery partition. All is not lost. You’ll
need to download the Mojave installer from the Mac App Store and use it to install Mojave in
Parallels.
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Now that Catalina is released, Apple doesn’t display an option to download Mojave from the App
Store, but it’s still on Apple’s servers. If you search deeply enough on Apple’s web site, you can
find the web address that opens the App Store page where you can download the Mojave installer.
Simply visit this Mojave page, and the App Store will offer the Mojave installer for downloading.
Or, if you prefer to download and install the previous operating system, visit the High Sierra page.
Choose the cloud icon to download the installer. Your Mac will ask if you really want to download
it; confirm that you do, and wait until it gets downloaded to your Applications folder. Don’t run it!
Instead, start Parallels Desktop, use the File/New… menu to open the Installation Assistant. Click
on the center icon, “Install Windows or other OS from a DVD or image file.” The next screen may
show the Install macOS Mojave installer; if it doesn’t, drag the Installer into the window and follow
the prompts to create and use a Mojave virtual machine, as in steps 4 through 10 above.
If you have VMware Fusion, you’ll need to use the same procedure whether or not you’ve updated
to Catalina. Start Fusion, click New… on the menu to open the “Select the Installation Method.”
You’ll see an option to “Install macOS from the recovery partition.” Don’t be tempted to use it,
because it will tell you that it couldn’t find any recovery partitions, even if you know perfectly well
that a recovery partition is there. I’ve asked VMware about this bug, and maybe it will get fixed in a
future version.
So, instead of using the Recovery Partition, you’ll need to download a Mojave or High Sierra
installer, as described above, and drag it into the Select the Installation Window. Follow the
prompts to install a virtual machine. When the new virtual system starts up, use the Virtual
Machine/Install VMware Tools menu to install the VMware Tools. After restarting the virtual
machine, drag your 32-bit apps into it and run them in the same way you can run them in Parallels.
VMware uses the name Unity for the same option that Parallels calls Coherence; it runs an app in a
virtual machine in a way that looks as if the program is running in a window of your main macOS
installation.

You Can Run Wine-Based Apps, Too
What if you’re using a Wine-based app to run a Windows game or app? In almost every case, the
Wine-based app won’t run in Catalina. The easiest solution is to install Windows in Parallels
Desktop or VMware Fusion and run the app in Windows. This costs money—you have to pay for a
copy of Windows—and can be slow and complicated, but it’s the only solution right now. The most
prominent vendor of Wine-based software, CodeWeavers, plans to release a Catalina-compatible
version, but the job isn’t easy and it isn’t clear when the new version will arrive.
There’s one exception to the rule that Wine-based apps won’t run in Catalina: If, and only if, you’re
running 64-bit Wine, and if, and only if, your Windows app is a 64-bit app and one that’s simple
enough to run under Wine, then Wine can run it in a window under Catalina. The most effective
way I’ve found to accomplish this is to use the brilliant Wineskin Winery app—an open-source
project by a programmer who uses the name doh123—in the form of its unofficial update by a
programmer who uses the name Gcenx. (The original Wineskin Winery won’t run under Catalina.)
If there’s enough interest in this subject, then we’ll post a how-to guide here, but there are probably
too few 64-bit Windows apps that are usable under Wine to make it worth your while. Interested
readers can search for “Unofficial Wineskin update” to get started, but be prepared to bang your
head on the table a few times until you figure it out.

Edward Mendelson										GUM		
						

(I have used Parallels for many years running Windows on my iMac
so as I can run Family Tree Maker for Windows and MS Access that
runs the GUM Newsletter mailouts. I guess if I wanted to update to
Catalina I have already got Parallels. Why do I run Family Tree Maker
for Windows as well as Family Tree Maker for Mac? So as I can use the
plugins and also write about FTM Win for GUM readers. As for
MS Access, it is only available for Windows. Ed).
https://www.parallels.com/au/products/desktop/
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Confessions of a Poor “Sourcerer”

T

he following are a few Sourcing tips I have learnt, which may help others to avoid some of my
FTM sourcing pitfalls. Remember, that Facts are fiction if they are without Sources. Sources
matter.
Recording sources means that you avoid wondering, later, where a fact came from. It value adds to
your research. Being able to go back to the source you have recorded allows you to re-evaluate your
information.
Even discarding Fact information that no longer matches other known Facts for a person, can be
difficult, if it is un-sourced, as it could mean losing the only true fact in a data set, or you could be
losing something that creates a genuine and interesting anomaly.
1.
When you begin sourcing. Try and grasp a basic concept of the hierarchy of source
recording. Tana Pedersen described this clearly in “The Official Guide to Family Tree Maker, 2010”.
In summary she suggests, a Source is an unchanging fact about an item or object. E.g. ‘England and
Wales Census, 1901’;
Source Citations, on the other hand are the parts of a source fact that can change, e.g a listed
county, town, Enumeration District, page number etc.
2.
Keep Sources to a minimum, but not Source Citations. When originally deciding on my
Sources, I made too many new entries based on spurious subdivisions which I thought would be
useful to me, or “interesting” but which soon became unwieldy. Each time I searched for a Source I
had too many listed to look through, making my Sourcing task more time consuming and tedious.
For example, I originally divided English Census material in to counties as well as years, thinking
it would be interesting to see where my sources were distributed (Perhaps a Sorcerer’s Apprentice
approach), however, I subsequently realised that a Source’s only job is to be a Source and that more
Source titles may not be merrier.
3.
Use titles for sources that you will remember. At one stage early on in my ‘Sourcery’, I
had IGI and Family Search as separate entries, not realising that they were the same as they had
been titled poorly, (by me). I also once had an entry like- “First Hand: John Smith, and separately
“Smith John: Personal History”, having an inconsistent method of recording, led to unnecessary
duplication. Check what you will see of the Title in your Source list, the first word can be important
as you will scan down alphabetically when looking for a source.
4.
I now combine and expand Source titles, when a new Source file fits well with another.
E.g. I began with “The Age” then went to “Newspapers: The Age” and now this has evolved into
“Newspapers, Gazettes and Directories”, with “Newspapers, The Age” as a Source Citation. This
could be done on a country by country basis, but for me, currently, I am happy to add this into each
entry citation.
5.
I take time to make a media shot of my Source if it has more than about 10 words on it.
(In which case, I just type all the information into the source citation text box). I save each media
image to my computer and then back into my FTM program so that none disappear irretrievably. I
caption all media by Surname of family, forename, item and date. I put the head of the family first
and put nee___ as appropriate, as all my files are by birth name. This way all my media files can be
put into family Name sub-folders on my computer, and they will appear in alphabetical order.
6.
Take time to record all necessary details as sometimes all details are not seen on an
individual media file page. For example, if using English Parish Records, I record church names,
as for example Toxteth Park, a borough of Liverpool in Lancashire, England, has nine Anglican
churches, seven Methodist etc. so I would always indicate the church name in my source citation,
e.g. St Cleopas Church, Toxteth Park, where my grandmother played the organ, her father taught
Sunday School, and where my grandparents married. You may have to go back to the beginning of
the whole document set in your record source to find this information.
Page 29 of 36

Victorian GUM Inc. Newsletter, December 2019
7.
Don’t use abbreviations, even if they seem obvious and always include the state/county
and country. Otherwise, how is it to be clear to our yet to be discovered, American cousins, if you
meant a relative was born in Melbourne, Victoria, Australia, or Melbourne, Florida, United States
of America, or how do you decide between Launceston, Tasmania, or Launceston, Cornwall?
(And there are 13 Aberdeens in the USA Ed)
8.
Another error of mine, was my attempt to use the FTM Sourcing templates based on
Elizabeth Shown Mills work for largely American Sources. I found that although the process guided
me neatly through the Source hierarchy and was simple to follow, the guide itself was too inf lexible
to accommodate Australian records and my needs. I was often forced to use template titles that
didn’t ref lect Australian data. For example, the Category, “Printed government documents” only
offers Congressional or National Archives (US) Guides as Options, and as a result I have ended up
with some poorly entered data which I still need to find and fix.
9.
I like to record primary Sources, where I can, not just a secondary Source like Ancestry, as
a kind of insurance policy, (many may disagree). However, when I do this, I record both clearly and
together, in the source citation detail area, in order to preserve convenience as well as accuracy.
10.
Finally, set aside time to fix errors because as every hard-working Sorcerer knows, it won’t
just happen by magic. Friday 13th of December, 2019 or Friday 13 March, 2020 could be good dates
to diary for this!

Cathy Carman								GUM
The Sourcerer or Sorcerer?
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Free Legacy Family Tree update now
available (version 9.0.0.332)
November 01, 2019

Legacy has announced another great new update for Legacy Family Tree 9 users (free) to download.
It's mostly a maintenance update which provides fixes to minor issues that have reported. It is a
mandatory update for those wanting to continue using the LegacyFamilySearch tool. So download
the update to get the best Legacy ever!
https://legacyfamilytree.com/DownloadUpdate.asp
See the download instructions below for step-by-step instructions on installing this update.

What's Been Fixed
View the October 28 release notes here. https://legacyfamilytree.com/RevisionHistory9.asp

How to Update
For Deluxe Edition users, all you have to do is connect to the Internet, start Legacy 9, and click on
the "Install and Download Now" link on the Legacy Home tab. (If you're reading this from within
the Legacy Home tab inside of Legacy 9, you'll first need to click on the Home button in the top left
of the Legacy Home tab which looks like the following picture:

If you are a Standard Edition Legacy user, you will need to visit our website. Go to
http://www.legacyfamilytree.com/DownloadUpdate.asp and follow the instructions.

More Info
https://news.legacyfamilytree.com/

Geoff Rasmussen										GUM
Reported by Maree Luci
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Ancestry® Expands Reference Panel to Deliver More
Precise Results and New Regions

C

onsumer genomics is a new and evolving field and Ancestry® is at the forefront, constantly
developing new ways for you to learn about yourself through DNA. Today, we’re proud to
announce that our team of scientists have increased the AncestryDNA® reference panel to more
than double its previous size with samples from more places around the world, resulting in the
latest update to AncestryDNA ethnicity estimates.
The expanded
AncestryDNA reference
panel helps deliver even
more precise regions in
West Africa, north-western
Europe, the Americas,
Oceania, and Southeast
Asia.

Over the next several
months, AncestryDNA
customers may receive
updated ethnicity
estimates, thanks to our
expanded reference panel, which allows us to determine ethnic breakdowns with a higher degree of
precision. This means there may be some changes to your results.
For example, previously we had North and South America as two large regions: Native American–
Andean and Native American–North, Central, South. With this new update, we are able to refine
the areas into 11 smaller ones. If you received one of the older regions before, your new report
will most likely have one of the newer, more precise regions instead like Indigenous Eastern South
America, Indigenous Cuba, and Indigenous Americas–Mexico, among others.
Because we have introduced new improvements, many of our customers whose ancestors lived in
Africa can also expect changes with this update. For example, someone who has Nigeria and Benin/
Togo may see an increase in their Nigeria percentage and a decrease in their Benin/Togo region.
This advancement enables us to deliver improved results in West Africa and globally to enhance the
experience across diverse populations including improvements and region realignment in northwestern Europe, the Americas, Oceania, and Southeast Asia.
Here’s how we do it: At Ancestry, we use cutting edge science to study the DNA in your saliva to
reveal your ethnic origins. After your DNA is extracted, we analyse your genome and survey over
700,000 locations in your DNA. Then our science team uses an advanced algorithm to compare
long segments of your DNA to the DNA of people in our reference panel who have deep family
histories from specific parts of the world. This unique reference panel largely comes from our
database, and their heritage is verified through Ancestry family trees to provide the most accurate
picture of your ethnic origins when your results arrive.
With 15 million people tested and more joining our network each day, we expect that the number
and granularity of regions we can offer will continue to increase over time. This latest update is just
one way of fulfilling our promise to continuously improve our product and your experience.
This update is completely free to our existing members and provided to new customers at no
additional cost. We encourage you to look at your ethnicity results regularly to explore your latest
estimate.
To view a full list of all our regions, please visit:
https://support.ancestry.com/s/article/List-of-AncestryDNA-Regions

Ancestry			
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What’s Happening in GUM?
Members may be amazed at some of the behind the scenes activities that go on as part of running
GUM.

The GUM Accounting System
For Example. Our accounting system is called Reckon which we have had for many years. It keeps
track of all the payments and receipts, and produces reports like the Balance Sheet, and Income
and Expenditure details, etc. Recently the Reckon supplier surprised us by advising that they were
ceasing support for Reckon and it would stop working even although we had purchased what was
previously advised was a full lifetime version. Bit like those Map lifetime updates we wrote about a
few months back. “Lifetime” seems to only mean the period to which the supplier will support the
version, or as the ad used to say, “Oils ain’t oils”.
Some quick footwork by Treasurer Bob Mullner ensured that we arranged to extend the operation
until 2022 and that he updated our records to the current Reckon version without losing a dollar.
Well done Bob!
The treasury gang of Alyson and Bob (Bonny and Clyde?) has also been finding gremlins in the
current web site and hopefully have now remediated most of them. This should make logging in,
paying your subs online, etc., less of a hassle.

Leaving Phone Messages
The GUM office has a good answering machine but if you leave a message please, please, PLEASE
state the return phone number slowly and clearly and repeat it. Over the year we have a number of
messages that we could not respond to because the caller’s message was indistinct. Even some with
only part of the return number stated. So please help the office volunteers to help you by leaving a
clear message or, alternatively, send an email to info@vicgum.asn.au asking for someone to call you
back and also advise the phone number in the message.

Subscription Reminders
We send out four reminders. One from the webpage, and two from the Membership Secretary
(Due and Overdue 1 month) plus a Membership Due reminder with your newsletter. Any more
and I think we would be hassling people. Our membership sub is still only $50 per year unchanged
since about 2013 and less than a cup of coffee per month. (See page 34). If you go overdue, your
newsletter and GUM membership benefits including GUMNET, immediately cease, (you are
unfinancial) so please assist the GUM volunteers by responding to the reminders promptly.

Email Changes
You would be surprised how many members do not advise us when they change their email and
then on average 6 months later complain that they have not received a newsletter or seen GUMNET
since June or something. GUM has no way of knowing if you change your email unless you tell us.
So please help GUM as well as helping yourself by promptly advising us. As usual, an email to
info@vicgum.asn.au will do the trick.

Season’s Greetings
Finally as editor could I add my greetings for the Christmas season. Christmas can be a great
opportunity to update family information and having a few charts conveniently lying around can
help.

John Donaldson										GUM
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GUM Book

So you are Totally New to Family Tree Maker Book (now available)
New third edition. The first in a series about FTM, this book covers
the absolute basics for new users, so that users with little computer
knowledge can get up and running. New third edition Specifically
revised for FTM 2017 and also FTM 2019 and is in full colour
Cost: $25.00 non-members $30 (includes postage)

GUM CD
DVD

45 videos

Instructional Video
Second Edition 2.2

NEW and Revised GUM FTM Instructional CD Version 2.2
Second Edition (see page 15 of the November 2018 newsletter for
details)

March 2018

Exclusive to GUM. Contains 45 tutorials (up from 26) on using
Family Tree Maker 2017. Also suitable for FTM 2019
Play them as often as you like.
			 A MUST for all FTM users!
			
Cost: $10.00 members $15 non members (includes postage)			
												GUM
© Copyright 2018

Family Tree Maker
(Day)
The first Friday of the month at
Wadham House
1:00 pm start.
Cost $2.00
johndd@iinet.net.au
Last Meeting 2019:
6 December
Breakup lunch

Geelong & Bellarine
FTM Group

Self- Help Groups

The third Monday of the month
at Wadham House
7:30 pm start.
Cost $2.00
ftmusers@vicgum.asn.au
Reunion User Group
First Friday of the month at a
private house Elwood
2:00 - 4:00 pm
Cost $2.00
reunionusers@vicgum.asn.au
Friday 6 December

Ballarat FTM Group
Meeting the Third Sunday
of Every Second Month At
McDonalds

marcusgrove10@bigpond.com.au

Last Meeting 2019:
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Last Meeting 2019:
18 November

Last Meeting 2019:

Meeting the third Monday of
each month at South Barwon
Community Centre,
Mt Pleasant Rd, Belmont
4:30 - 6:00 pm
Contact Maree

18 November

Family Tree Maker
(Evening)

GUM

Sturt Street Ballarat.
at 1:00 pm
Contact Maureen
chatty44@bigpond.com
Last Meeting 2019:
17 November
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GUM MANAGEMENT TEAM
President
Doug Elms
Vice President John Donaldson
Secretary
Jim Hill
Treasurer
Bob Mullner
Committee:
Laura Black
John Killip
Malcolm Kingston
Alyson Kosina
Margaret Ockwell
Robyn Pidcock

03 9809 4854
0438 670 003
0405 320 762
03 9509 8129
0425 703 350
03 9569 6137
03 8707 5994
0410 611 259
0417 161 112
03 9842 1036

Membership Officer:
John Donaldson

0438 670 003

Office Manager:
Bob Mullner		
03 9078 4738
Wednesday (10:30 am-2:30 pm)
Merchandise Sales
03 9078 4738
& Distribution
email: 		
sales@vicgum.asn.au

Victorian GUM Inc.

VICTORIAN GUM (GENEALOGISTS
USING MICROCOMPUTERS)
INCORPORATED
WEBSITE:
EMAIL:

www.vicgum.asn.au/
info@vicgum.asn.au

FACEBOOK: www.facebook.com/VicGUM
Reg No: A0023358X ABN 47 032 151 571
Level 4, 460 Collins St Melbourne 3000
[Enter from 83-89 William Street]
Postal Address:
PO Box 397 Collins St West VIC 8007
Phone:		
03 9078 4738
Office email: gumoffice@vicgum.asn.au

NEWSLETTER TEAM

Any General Committee Enquiries

Editor: 		John Donaldson
Legacy Reporter:
Maree Luci
Proof Readers:
Cathy Carman
			Marjie Hales
			Tricia Parnell
			Yvonne Toomey

info@vicgum.asn.au

NEWSLETTER DEADLINES

GUMNET MAILING LIST

Final copy for each issue of Victorian GUM Inc.
News is due with the Editor by the first day of
the preceding month.

Webmaster:

webmaster@vicgum.asn.au

To post to GUMNET
gumnet@lists.vicgum.asn.au

CURRENT GUM LIFE MEMBERS
Bruce Fullarton
Merv Leeding
Laurie Thompson
Doug Elms

John Wolff
Robyn Fisher
John Donaldson
David Stephen

Registered by Print Post Publication
No. PP100018445 ISSN 1324 2652
© Victorian GUM Inc. and individual authors.
This newsletter may not be redistributed to
other parties by the original member who
received it.
Produced in Adobe InDesign CS6

NEWSLETTER CONTRIBUTIONS
Copy is preferred in electronic form and may be
sent to the Editor at PO Box 397 Collins St West
VIC 8007, or via email to:

editor@vicgum.asn.au
Most file formats can be handled. If graphic files
are included in your article, (TIF preferred),
please also send them separately and indicate
their placement in the text via a PDF of the
complete article.
Every effort is made to ensure that the
information in this newsletter is correct, but
no responsibility is accepted for errors or
omissions. The views expressed are those of the
individual contributors.
							
					GUM
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GUM Payment Options
Cheques and money orders (including the relevant postage) are to be made payable to
Victorian GUM Inc. and sent to: PO Box 397 Collins Street West VIC 8007. credit card
facilities via telephone are available through VicGUM®, The Genealogical Society of
Victoria Inc. (GSV) in Melbourne. (The minimum amount is $10.00).
For details of what is available see the VicGUM® merchandise page 34 or ring the GUM
Office 03 9078 4738 Wednesdays, 10:30 am to 2:30 pm; or go to:
www.vicgum.asn.au/ . Then click on Software & Sales.
Bank Account: Merchandise can be purchased via the GUM Website, through your bank
or by using your internet banking facilities. The details you require are:
ANZ Bank

BSB No: 013-030

Account No: 79 87792

If using direct bank deposit, please, please PLEASE also email details of your order/
subscription renewal, etc., including your bank name and/or transaction number etc.,
to: info@vicgum.asn.au so as we can match the payment.
You can also pay with your credit or debit card using the secure PayPal facility.
(You do not need to have a PayPal account to do this).

												GUM

One Year

GUM Subscriptions

Joining Fee (once off)			
Yearly Subscription 				

$15.00
$50.00 (Includes 12 emailed newsletters)

Joint Members (2 members at the same address)
Joining Fee (once off)			
Yearly Subscription 				

$25.00
$65.00 (Includes 12 emailed newsletters)

Two Years
Joining Fee (once off)			
Biennial Subscription 			

$15.00
$100.00 (Includes 24 emailed newsletters)

Joint Members (2 members at the same address)
Joining Fee (once off)			
Biennial Subscription 			

$25.00
$130.00 (Includes 24 emailed newsletters)

Your subscription status is shown with your newsletter email, please check it each month
To Pay online

https://www.vicgum.asn.au/ and click on the VICGUM MEMBERSHIP link
												GUM
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